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What is File Management?  

A file is simply a collection of data stored in a way that the computer can read it. Every 

command you give to a computer involves using some sort of file. When you start up a word 

processing package you are running a program, and you will need to be able to save the 

information that you input into a file.  Subsequently you may wish to make further changes 

so you need to know where to find the saved file, and perhaps you’ll want to print it out or 

copy it from a hard disc onto a pen drive/memory stick.  We are going to introduce two 

options for seeing and organising your files, namely using the Documents folder and Windows 

Explorer (simply Explorer, from here on).  

 

Seeing what is on your Computer  

Select the Documents option from the Start menu.   

 

A window appears showing various icons, which include 

the drive letters for disc drives where files can be stored.  
 

Note: Documents is the default storage area whenever 

you save a file on a PC.  On campus PCs this will always 

be linked to a network drive.   
 

A drive is a device for storing and reading data. It 

contains a disc or discs on which the data is stored as files.  

 

Drive C: is the computer’s in-built hard disc and D: a DVD/CD-Rom drive. 

Drive E: is usually available for other portable storage, such as USB pen drives.  
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If you are using a computer that is part of a cluster, you may also see an icon 

like this, indicating a networked drive. This means the physical drive has a 

different location from the computer that accesses it.  

 

 

The Documents window above shows all the internal and external drives available on a computer. 

This is also identified by a letter; on university campus computers, this is usually H, K or M. 

Placing the mouse cursor over the drive icon will display drive information.  To see the files 

stored on a drive, double click on its icon. 

 
 

It is important to understand that files you save while logged on to the CSCE on campus or 

via CSCE Remote will be stored by default in your Documents library which is in a 

network storage area on campus.  

 

You should never attempt to save anything to the C:drive on a CSCE computer.  You will not 

be able to find it again even when you log on to a CSCE computer.  Anything you save to 

your Documents library (on your H, K or M drive) will be available to you from any CSCE 

machine on campus or via CSCE Remote. 
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Storing and Accessing Files 

Files can be stored on your computer in two ways.  They can be added from another source, 

e.g. downloaded from a web site or they can be copied from an external source, such as a disk 

or USB pen drive. 

 

A USB Pen Drive is attached to the USB port of a PC, after which it can be treated 

like any other drive on your PC. You can copy files to or from it by simple drag and 

drop or by using copy and paste in your Documents folder.  

When you have finished using the USB Pen Drive, make sure to click on the 

Safely remove USB Mass Storage Device option on the Taskbar before removing it.  

Files are also stored on your computer when you save a file, for instance when you save text 

that you typed in a word processing program. 
 

To save a file click Save on the File tab and in the dialog box that appears type a filename.  

Then press Enter or click the dialog box’s Save button. 

Folder/File Location List Box Down Arrow Button   Buttons  
 

  

When you save a file you should give it a suitable name, typing in the File name box. 

To save a file from a web page, right-click 

with the mouse on the file name.   

In the menu that appears, select Save Target 

As (or in some browsers Save File As) and 

save to your Documents folder. 
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You can save in various formats.  We’ll use the example of an MS Word document: here the 

default is *.docx  (default formats for other applications are discussed later in this document). 

 

To save in other format, click on the Down-Arrow button by the Save As type box and a list 

of file types will be displayed for you to select from. 

To open a file click Open on the File tab and in the dialog box that appears search in the 

folders for the file, select it and then click Open.  The Open dialog window is very much like 

the Save window, except that you have an Open button instead of a Save button. 

 
 

Different folders can be selected from within the main Documents folder. You open a folder 

by double clicking on it – or by clicking on the little arrow symbol () beside each folder 

displayed in the left hand side panel.  Note that in the above image the track to a folder 

named British History is shown.   
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Finding Files on your Computer 

As you save and download files your filestore will grow until you will find it difficult to find 

things unless you learn how to search for and organise your files.  
 

The image below shows the contents of an area dedicated to your personal filestore, your  

Documents (on your Home drive).  Note: there are some extra folders here, created by the 

user. We’ll look later at how this is done.  Within this area are a number of icons: each icon 

represents a different type of object.   

 

 
 

The most common icon you see looks like a paper document wallet, and this 

represents a folder into which can go files and other folders.  

 

Now when you select a folder, a large icon appear on the status bar which gives you 

more information about it.  In this example the folder is empty – the icon tells you 

this without opening it.   
 

This icon is also used when your are viewing the contents of a folder (with none of the 

contents selected) to indicate you are ‘looking inside’ the folder. 
  

A folder which contains files displays, on the status bar, the icon to the right of 

this paragraph.   To see the contents of a folder, double click on the folder in the 

main window.    
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For instance we may look inside the My Essays folder seen in the above image.  Here we can 

see that there are three files stored within the My Essays folder, and from the icons we can 

tell that two are word processed document created with Word and one is a spreadsheet file 

created with Excel.  Later on we’ll expand on the names given to these files.  

 

 
 

When you select a file within a folder, a large icon appear on the status bar which 

tells you what kind of file it is.  In this example the icon on the status bar tells you 

that it is an Excel workbook file.  You will notice that the icons within the folder 

beside the file names are miniature versions of the large icons shown on the status bar.  

You can change how files are displayed by choosing an option from the View menu.  
 

 
 

Here the Details view has been chosen showing a tiny icon and details like Date modified. 
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Default view on many computers is Large or Medium icons; some are shown below. 

 

Another way of identifying a file is by its extension – in some of the earlier examples above 

you will have seen the Excel file has the extension .xlsx and Word files have the extension  

.docx which are typical MS Office 2007-2010 application files. 

 

Extensions are used to help recognise the file type (i.e. the sort of data which the file 

contains); if the program, which you are using, cannot recognise a file it will not be able to 

use the data in it. Files with an extension .exe are usually programs, which you can run, 

whilst those with .docx are usually documents created by MS Word .   

 

There are many file types and corresponding extensions. Below is a table of some of the most 

common you will come across: 

 

Text files Presentation files Data files Image files 

.docx  MS Word 

.txt     plain text file 

.rtf    rich text file 

.ppsx  PowerPoint Slide Show  

.pptx PowerPoint  Presentation 

 

 .xlsx  Microsoft Excel  

.accdb Access Database  

.bmp bitmap image 

.gif or .jpg  Common 

formats for images  

 

 
 

Note the buttons at the top of these windows.  The Back button allows you to return to 

the previous view – for instance from “My Essays” back to the main Documents 

window.  The Forward button takes you forward, so you can switch back and forth 

between two areas.  

 

If you click on the little down-arrow beside the 

Back or Forward you will see a menu of all the 

folders you have viewed recently.   
 

This saves you having to click many times to reach 

an earlier folder.  

Here are some typical icons you will often come across: 

these are the icons for the main Microsoft Office file types.   

If you are unsure what type of file an icon represents, 

select the file and information about it will be shown on the 

status bar alongside the large icon. 

  

http://www.google.co.uk/imgres?q=back+button+icon&hl=en&biw=903&bih=616&tbm=isch&tbnid=zymuZVh7-TXBAM:&imgrefurl=http://commons.wikimedia.org/wiki/Category:Arrow_on_round_button_icons&docid=1oQMJk6kdNnh3M&imgurl=http://upload.wikimedia.org/wikipedia/commons/thumb/b/b5/Torchlight_back.png/120px-Torchlight_back.png&w=120&h=120&ei=yT50UIvTHeev0QWl2oHQCQ&zoom=1&iact=hc&vpx=126&vpy=293&dur=660&hovh=96&hovw=96&tx=77&ty=33&sig=100788680108268743360&page=4&tbnh=96&tbnw=96&start=50&ndsp=20&ved=1t:429,r:0,s:50,i:292
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If you are not sure where a file is, using the Search option lets you enter details of a file and 

search for it by clicking the spyglass icon.  In the example shown below we see a search on 

a part of a file name; the file has been found and displayed along with its location. 

 

 
 

You can also check for files created or updated within a certain period by selecting the filter 

Date modified. 

 

 
 

As you can see from the above illustration you can select a general period (e.g. Earlier this 

month) or a specific period by date using the Calendar option.  

 

 
 

Another option is Size.  You wouldn’t use this when searching for a specific file.  But if you, 

for instance, were clearing out old files to make space you might want to see the biggest files. 
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Getting rid of the larger files that were no longer wanted would create the most space. 

 

What if you are looking for a file from months ago and although you know it’s subject/topic 

you can’t remember what it was named?  To be sure of finding such files you need to keep 

your folders organised.  This is done using the options found in the Organize menu. 

 

Organising your files  

It is up to you to decide how to organise your files, just as you would do if you 

were putting paper documents into folders, which are stored in a filing cabinet. 

The cabinet drawers will be labelled in some way to help you find a file quickly.  

Similarly in your computer storage you should store work for a particular topic in 

an appropriately named folder.   
 

Keeping your work organised is best done using the Documents window options.  Before 

doing anything with a file or folder you must select it by clicking on it once with the mouse.   

On the bar above the panel displaying the folders and files buttons are a number of Option 

buttons and menus (some of which are only active if a file is selected).   The most important 

for our purposes are Organise, Burn and New Folder. 

 

 
 

We’ll look first at the New folder option that allows you to create a new folder wherever and 

whenever you want. 

 

 

 

 

 

 

To add new folders, click on the New 

folder button in the Documents window. 

 

The new folder appears with its default 

name selected: overtype this to rename it. 
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Note: when you Save a file you can also create a new 

folder for it at the same time.  Then you save directly into 

the new folder. 
 

Folders can be nested in a hierarchical arrangement, so that top-level folders can contain sub-

folders, and so on down to individual files.  This helps you find things and it also keeps related 

material together. 

 

Keep your files organised and use sensible names for 

them – if you don’t do this you may have trouble 

finding files you want later on.  All your work files 

should be held in your Documents folder but within 

it you should create new folders to place files into 

and organise them. 
 

In the example shown here, a student has created a folder in their Documents folder, named 

History.   

   

Inside this folder are sub- folders representing different aspects of the main subject.  

Remember: you should give files suitable names too, for instance don’t just name your file, 

e.g. essay1 name it History_essay1_semester2.  

We’ll look now at the Organise, menu which allows you to Delete, Rename, Move or 

Copy a file. The Undo and Redo options are in this menu as well.    

 

To Delete a folder:  

 Check there are no files you wish to keep in the folder.  

 If there are any files you wish to keep, and you still wish to delete the folder, move 

these files to another folder.  

 Select the folder you want to delete then select Delete from the Organize menu  

(or click the delete key on the keyboard). 

 Confirm that you want the folder deleted by clicking on Yes. This moves the folder, 

and any contents, to the Recycle Bin.  
 

Remember that the Recycle Bin is a holding place for deleted files and that these  

files are not actually deleted from the computer until you empty the  
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Recycle Bin. (To do this double-click the Recycle Bin icon, and select Empty  

Recycle Bin from the File menu.)  
 

This means that you can get back folders that you have accidentally deleted.  However if you 

need to free up disc space the Recycle Bin should be cleared out from time to time.  

 

To copy a file:  

 Select the file you want to copy. 

 Select Copy from the Organize menu.  

 Choose and open the folder where you want to place the copy.  

o You also have the option of creating a new folder to store the copy:  

o Simply click the New folder button.  

o Give the new folder a name and press the Return key.  Open the new folder. 

 Select Paste from the Organize menu. The file will be copied into the folder.  

 

You can Move files in a similar fashion 

 

To Move a file:  

 Select the file you want to move. 

 Select Cut from the Organize menu.  

 Choose and open the folder where you want to place the file.  

o You also have the option of creating a new folder to store the copy:  

o Simply click the New folder button.  

o Give the new folder a name and press the Return key.  Open the new folder. 

 Select Paste from the Organize menu. The file will be moved into the folder.  
 

To rename a file, select it in the Documents window and choose Rename from the 

Organize menu.  

 

The file name will be highlighted and you simply type over it 

with the new name you want to give it. Remember to keep the 

same extension for the file name!  

 

If you copy files, create suitable names for the copies, so that you can tell them apart easily. 

But don’t change extensions or the application with which the file was created will not be 

able to read it any more. 

 

To delete a file, select it by clicking on its name and then choose Delete from the Organize 

menu or click on the Delete key. If you mistakenly delete a file, you can retrieve it by 

choosing Undo from the Organize menu. Alternatively, you can open the Recycle Bin 

and select the file you wish to retrieve, then click on the Restore button. 

 

  



File Management with Windows 7  

12 

Portable Storage Media  

PCs allow you to save data to different types of portable storage medium, which allow  

you to transfer files between computers which are not connected by a network: e.g.  

transfer files between your home computer and one on campus. Some PCs in the university 

clusters allow you to write to an R/W CD or DVD. CDs can hold as much as 750 megabytes 

of data and DVDs from 4.5 Gigabytes of data and upwards.  

 

Another storage medium is the USB Pen drive (also known as memory stick, flash drive, 

etc.) which can hold from 1 Gigabytes of data up to 256 Gigabytes. These can be used with 

any PC that has a USB port. These can hold more memory than a DVD and are more 

durable; on the other hand they are easy to lose and can present security problems. 

 

Read/Write CD  

You can save files to a writeable CD by copying using your Documents window or Windows 

Explorer. (Right-click on the Start button and choose Open Windows Explorer). 
 

To begin the process, insert your CD into the D: drive and open the Documents 

window or Windows Explorer to access the files you want to copy.   

Select the files and then click the Burn button.   

 
 

The D: drive will be shown and  temporary copies of the files to be burned will be displayed.  

Click Burn and the following window will appear.  
 

 

Click Next and the burning process will begin. When finished, don’t forget to remove the 

CD from the PC – especially if you’re using a Campus PC! 
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Examining and Running Files 

The way in which the files and folders are presented to you, and the 

amount of information given about them, can be changed.  

 

To do this, select the View menu and choose from Large Icons, 

Medium Icons, Small Icons, List or Details. The Details option will 

display the name, size, type and the date that the file was last modified.  
 

  
 

Knowing when it was last used helps you identify the latest version of a document of which 

you may have multiple copies as backups, all with rather similar names.  

 

A file can be run straight from the My Computer  or Explorer window. You can do this by 

double-clicking on it or by right-clicking and selecting Open. If the file is a program 

(usually with an .exe extension) it will run. If it is a data file, such as a word processing 

document, it will open the application it needs, then open itself. This will only happen 

successfully if the application is already on your computer. Thus, double-clicking on a word 

processing file will only open the file if you already have the word processing software 

installed.  

 

Some files will already be pre-set to open this way, but sometimes you may wish to open 

other file types. To do this, first click on the file you wish to open, then select Open With 

from the File menu and select the appropriate application from the list displayed. You 

should make sure the Always use this program to open this file box is ticked if you expect 

to be using this file type regularly. 

 

Backing up Files 

Backing up files is very important. Even though computers nowadays are very reliable, 

accidents can occur - and human error is always possible. You should always keep a backup 

of any file you create. When working on a file, you should back up at regular intervals so 

that, if anything goes wrong, you will only have lost a few changes.  

 

At university if you store files on a networked file server, which you will do when you save 

to Documents on a campus networked PC, backups will automatically happen at regular 

intervals.  So if you do accidentally delete files they may be able to retrieve copies from 

Clicking on any of these headings (at the top of the section of the window 
displaying the folders/files) will arrange them in a suitable order – e.g. clicking 
on Name orders alphabetically, on Date Modified by date, etc. 
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routine backup servers.  

 

You can’t depend totally on the network back up, however.  Back-ups are made regularly 

throughout the day but there might be a system failure just before a back-up is due and you 

could easily lose as much as an hour’s work – if you haven’t been making your own regular 

backups.  Make more than one backup of files that are important, and keep them in different 

places.  And, if you back up to portable storage (e.g. disc or USB pen drive) don’t forget to 

remove it from the PC and put it in safe place. 


